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iINndows

A Back to top

This quickstart will help you set up your MS Windows machine to explore the sourcecode of
Bonsai or develop and debug your blender scripts in VSCode. This has the benefit of having
a complete development environment where you can explore the code, make changes,
debug (break-points, watch variable and stack contents, etc. ) and see the results in blender

e Steps 1-6 will get you started with VSCode to develop and debug python scripts in
Blender and explore the Bonsai sourcecode and documentation.

e Steps 7-14 will allow you to interact with GitHub to make changes to the Bonsai project.

We will be using Windows 11 as our operating system and Visual Studio Code as our

Integrated Development Environment (IDE) and we will create a dedicated user for
Development.

/" Note

In the following steps we wil be installing a number of applications. There are several ways to install them and
that has impact on whether Windows is able to find the relevant binaries. In general if you have issues in the
stpes below related to not being able to find binaries, please check that the installation path is in the PATH
environment variable. You can hit “Windows” key and write “environment variables”.

) environment variables

Microsoft Bing Apps Documents Settings Folders Photos

Best match

Edit the system environment
g2

™ variables =

Control panel

Edit the system environment variables

Settings Control panel

gea Edit environment variables for
“ your account

And then go to [System Properties » Advanced ~Environment Variablesj.

Check that the installation path is in the PATH variable. If not, you can add it by clicking in the .

r

User variables for falke

Variable Value

ChocolateylastPathUpdate  133874001926539118

OneDrive C\Users\falke\OneDrive

Path C:\Users\falke\AppData\Local\Microsoft\WindowsApps;C:\Users... |
TEMP C\Users\falke\AppData\Local\Temp

TMP C\Users\falke\AppData\Local\Temp
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A Backtotop . Edit... Delete
System variables
Variable Value
NUMBER_OF_PROCESSORS 16
0S Windows_NT
Path C\Python313\Scripts\;C:\Python313\;C:\Windows\system32;C\\...
PATHEXT .COM;.EXE;.BAT;.CMD;.VBS;.VBE; JS;.JSE;. WSF;,.WSH;.MSC;.PY,.PYW

PROCESSOR_ARCHITECTURE AMDG64

PROCESSOR_IDENTIFIER AMD64 Family 25 Model 33 Stepping 0, AuthenticAMD
PROCESSOR_LEVEL 25

PROCFSSOR RFVISION 2100

New... Edit... Delete

oK Cancel

1. Create Development User: Open Windows Settings (typically hitting “Windows” key and

writting “settings” in the search field) and then go to (Accounts » Other users]. Click on

and then add a new user. We will name it falken10Ovadl.

& Settings

e vl Accounts > Other Users

falken10vdi@gmail.com

Other users

Find a setting ¢
_ Add account

Home
System

Bluetooth & devices

Network & internet =* Microsoft

Personalization Create account

= Apps

someone@example.com

Accounts
Get a new email address

Time & language
Add a user without a Microsoft account

Gaming

Accessibility

Privacy & security

Windows Update

Terms of Use  Privacy & Cookies

2. Install Blender for the created user: We will install blender locally in the users home
directory. We must check that we are following the Systems requirements.

We will download Blender 4.2 from the Blender download page. In particular, we take the
4.2 LTS for Windows.

We will download the Windows - Portable (.zip) version:

https://www.blender.org/download/release/Blender4.2/blender-4.2.8-windows-x64.zip

| B DU SURGY I QDR <] [DEUR SURO B s | PPV PR G I [N IR B 8
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UTIZIP LUIe 1ie In wie user rnoire airecLory. Imn our cdse itis .
|\Usersl\falke\Documents\blender-4.2.8-windows-x64 (the user falken10vdl has as home

directory C:\Userslfalke).

) A Back to top ‘ _ .
Congratulations! You have now Blenac. «.ocuwew «Ocally in your machine. You can launch it

by double clicking in blender.exe which is situated in the previous folder.
Now install the Bonsai Blender extension. Follow the Unstable installation.

Congratulations! You have now the Bonsai Blender extension installed in your local
Blender installation.

3. Install VSCode: Log in as the new created user (falken10vdlin this example) and install
Visual Studio Code.
4. Adjust Python version in VSCode as in Blender: This is a good practice step to ensure

that the Python version in VSCode matches the one in Blender.

Check the Python version in Blender by going to |Scripting|. In the Python Console you can
see the version number of the Python interpreter

(Unsaved) - Blender 4.2.7 LTS

Help fode ting UVEditing TexturePaint  Shading Animat Renderin
Select Add Object 1 Global v Pv [@v View Text Templates B+ + New @& Open

Options v

In our case it is version 3.11.7

We will need to install the closest version in our Linux machine.

We check in either in Microsoft store or Python Downloads.

The closest version is 3.11 in Microsoft Store. So we installing by clicking in .

After this, we have the 3.11 python version installed in our machine. It is reachable by

typing python3.11 in the terminal.

python3.11 -V
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Command Prompt X ol

C:\Users\falke>pythoion

Python 3.11.9

C:\Users\falke>

Launch VSCode and go to the Extensions tab, search for Blender Development and install

) Walkthrough: Setup VS Code

o w5 | Blender Development v0.0.25

lopment [Experimental Fork]

er Python SETFATA >0 Get Started with VS Code
P SIS TEl BT

SetUp Copilot for Free

of midnight blue dark theme
Moon Violet Dark Plus
DarkPlus Chocolate

G Blends

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom

left corner. Select the Python interpreter that matches the one in Blender. In our case it is
3.11.

File » New File... » Python File

i

@ EXPLORER

“ NO FOLDER OPENED =+ Create Virtual Environment.

Select Interpreter

B3 Enter interpreter path
{23 Use Python from ‘python.defaultinterpreterPath’ setting
Open Folder Python 3.13.2 64-bit C:\Python313\python.exe Recommended

Python 3.11.9 64-bit (Microsoft Store)
Opening a folder will close all currently operi editors. 10 keep
them open, instead

You have not yet opened a folder

You can clone a repository locally.

Clone Repository

You can open a remote repository or pull request without cloning

Open Remote Repository

2025-03-28, 11:37
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To learn more about how to use Git and source control in VS Code

A Back to top

> OUTLINE
IMELINE

Congratulations! You have now a Python version in VSCode similar to the one run by
Blender.

5. Connect VSCode to Blender by means of VSCode’s extension: “Blender Development”:
This steps is crucial to be able to develop and debug scripts in VSCode ans interactivwely
see the results in Blender.

Launch VSCode and go to the Extensions tab, search for Blender Development and install

Get Started with VS Code

ith Copilot fo

Ol « o @ 0@ = o O

This will also install some Python related extensions.

Finally create a sample python file and check the Python interpreter version in the bottom
left corner.

[File - New File... > Python File]

Select Interpreter
EXPLORER

v NO FOLDER OPENED -+ Create Virtual Environment.

B3 Enter interpreter path

You have not yet opened a folder
2 Use Python from ‘python.defaultinterpreterPath’ settin
Use Python from "python.defaultint Path’ setting

Open Folder Python 3.13.2 64-bit C:\Python313\python.exe Recommended

5de 27 2025-03-28, 11:37


http://localhost:8000/_images/VSCode-python-ver.png
http://localhost:8000/_images/VSCode-python-ver.png
http://localhost:8000/_images/VSCode-blender-extension.png
http://localhost:8000/_images/VSCode-blender-extension.png
http://localhost:8000/_images/VSCode-python-ver.png
http://localhost:8000/_images/VSCode-python-ver.png
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#

Windows - Bonsai 0.8.2 documentation http://localhost:8000/quickstart/ide/windows_ide.html

Opening a folder will close all currently opeiTcanoIs: 10 Recp

them open, instead

You can clone a repository locally.

Clone Repository
You can open a remote repository or pull request without cloning /I\ BaCk to top

Open Remote Repository

To learn more about how to use Git and source control in VS Code

> OUTLINE
> TIMELINE
X ®0A0 Ln1,Col 1 Spaces

6. Test that you can develop python scripts in VSCode for Belnder: Create a sample

blender python file under adirectory for example C:
|\Users\falke\Documents\bonsaiDevellscripts. You can use whatever blender python script
you want. We will use this one from the blender documentation:

Example Panel

import

class HelloWorldPanel/( . . ):

Creates a Panel in the Object properties window
= "Hello World Panel"
= "OBJECT_PT _hello"
= 'PROPERTIES'
= 'WINDOW'
= "object"

def draw(self,
= self.

Q)
="Hello world!", ='WORLD_DATA")

Q)

="Active object is: +

Q)

"name")

Q)

"mesh.primitive_cube_add")

def register():
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def unregister():

bpy.utils.unregister_ class(Hel A Back to top

if name_ == "_ main__ ":

print("Hello World: run from Blender Text Editor™)
else:

print("Hello World: run from VSCode")

print(f"NOTE. _ _name__ is : {__name__}")

register()

We have changed the last part of the script since running from VSCode has some subtle
diferences compared to running from the Blender Text Editor. In particular the special
variable __name__ is different.

Press CTRL-SHIFT-P and type “Blender: Open Scripts Folder”. Select the previous folder
where the script file is located

Press CTRL-SHIFT-P and type “Blender: Start”. Blender will start.

Press CTRL-SHIFT-P and type “Blender: Run Script”. The script will run and the output
will be seen in Blender!

As you can see below. We have set a break-point in line 37 (see point 13 below for
another example of setting a break-point). We can inspect in the left side the local
variables, global variables, add watches, check the stack, etc. For example we can see that
__name__ has a value of “<run_path>" Instead of “__main__".

RUN AND DEBUG D BonsaiDocsServer (IfcOpenshell) v &

VARIABLES
s Locals

> special

bl_label =
bl_idname
bl_space_t:
bl_region_type =
bl_context = "object

draw(self, context):
layout = self.layout

j = context.object

= layout.row()
w.label(text="Hello world!", ="'WORLD_DATA")

w = layout.row()
row.label(text="Active object is + obj.name)
ayout.row()
w.prop(obj, "name")

w = layout.row()
w.operator(“mesh.primitive_cube_add"

register():
bpy.utils.register_class(HelloWorldPanel

unregister():

bpy.utils.unregister_class(HelloWorldPanel

__name__

print(“Hel
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print(“Hello Worl
print(£")

register()

> CALL STACK
BREAKPOINTS

Once we continue execution we can check in the VSCode Terminal the output and in
Blender the panel created by the script.

oA P ror
1 140

CONGRATULATIONS! You have now a development environment ready to speedup your
python scripting in Blender.

6.X BONUS: Editing Bonsai Documentation: Please refer to Writing documentation for
deatils on ow to edit and contribute
documentation. Here we just summarize the steps to integrate that workflow in
VSCode and using Inkscape.

e Donwload and install Inkscape from Inkscape download page. In our case we will
use Inkscape 1.4 Windows 64 bit msi installer Inkscape download page.

e The file above has the style annotation for the Bonsai documentation. You can use it
to create your own diagrams.
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e Open some screenshot file you want to add annotations in Inkscape and at also open
this template. You can then copy paste from the temaplate to the screenshot file.

Warning

When copying the shapes for your convenience just make sure that you do not have selected the option
“When scaling objects, scale the stroke width by the same proportion” to keep the style width right.

. New document 1 - Inkscape

File Edit View Layer Object Path Text Filters Extensions Help

stroke width by the same proportion

Document Page Selection Custom

Image Size

e Once done you can export your edited screenshot as PNG to be used in the

docummentation. [File - Export...] and click in the Export button on bottom right

corner.

e As described in Writing documentation you need to have sphinx installed in your
system. One of the easiest ways is to use Chocolately. Then you can simply run the
following command in the terminal:

choco install sphinx

and then install the theme and theme dependencies:

python3.11 -m pip install furo
python3.11 -m pip install sphinx-autoapi
python3.11 -m pip install sphinx-copybutton

All these can be accomplished within a terminal of VSCode.

PROBLEMS OUTPU DEBUG CONSOLE TERMINAL PORTS

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> python3.11 -m pip install furo
Collecting furo
Using cached furo-2024.8.6-py3-none-any.whl.metadata
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e To speedup your workflow you can add the following VSCode files in the .vscode
folder of your cloned repository. In our case itis C:
\Users\falke\Documents\bonsa, T Backtotop Shell|.vscode

e Make sure to edit them before with the right paths in your system.

o launch.json

=] launch.json

File Edit View

{
// Use IntelliSense to learn about possible attributes.
// Hover to view descriptions of existing attributes.
// For more information, visit: https://go.microsoft.com/fwlink/?1inkid=830387
"version": "@.2.0",
"configurations”: [

{

. s
Build and Serve Docs",
"console": "integratedTerminal”

Ln1, Col1 635 characters % Windows (CRLF)

o tasks.json

B tasksjson X +

File 03 View

// for the documentation about the tasks.json format
"version": "2.0.0",
"tasks": [
{
": "Build and Serve Docs",
shell”,
: “"powershell”,
: [
NoProfile”,
“-ExecutionPolicy”,
“Bypass”,
" -Command"

“cd C:/Users/falke/Documents/bonsaiDevel/IfcOpenshell/src/bonsai/docs/;| - \\make html; cd _build/html; python -m http.server”
1,
"group": {

"kind": "build",

“isDefault”: true

b
"problemMatcher”: []

e Now you can use th debug tool in VSCode to regenerate the html documentation by
cliking the “Play” button BonsaiDocsServer ([fcOpenShell) in the top left corner of
the debug tool.

RUN AND DEBLX ‘®Bonsa\DocsSen/er (IfcOpen$ v ’f:}

“ VARIABLES

: Crea
Now let's find out how to interact with GitHub in order to make changes to

: Please refer to

documentation. Here we just summarize the steps to integrate that workfl

- Donwload and install Inkscape from

10 de 27 2025-03-28, 11:37


https://docs.bonsaibim.org/quickstart/ide/launch.json
https://docs.bonsaibim.org/quickstart/ide/launch.json
http://localhost:8000/_images/launch-jason.png
http://localhost:8000/_images/launch-jason.png
https://docs.bonsaibim.org/quickstart/ide/tasks.json
https://docs.bonsaibim.org/quickstart/ide/tasks.json
http://localhost:8000/_images/tasks-jason.png
http://localhost:8000/_images/tasks-jason.png
http://localhost:8000/_images/bonsai-doc-server.png
http://localhost:8000/_images/bonsai-doc-server.png
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#

Windows - Bonsai 0.8.2 documentation http://localhost:8000/quickstart/ide/windows_ide.html

- The file above has the style annotation for the Bonsai documentation

images/inkscape-annotation-template.png
idth: 100 px

A Back to top

some screenshot file you want to add annotations in Inkscape and

e Once the server is started you can open a browser and go to the following URL:

http://localhost:8000/ and you will see the documentation.

e In order to rebuild the documentation you need to stop the server and run the
command again. You can do this by clicking in the “Abort” button in the bottom right
corner of the debug tool.

CONGRATULATIONS! And happy documenting!

Now let’s find out how to interact with GitHub in order to make changes to the Bonsai

project.

7. Install GitHub related VSCode extensions: To facilitate the use of git commands and
pulling and pushing files from a local repository towards github, please install as well the
following VSCode extensions:

o GitHub Pull Requests
o GitHub Repositories

o Remote Repositories

Optionaly you can also install Copilot extensions

o GitHub Copilot
o GitHub Copilot Chat

i File Edit Selection View Go Run Terminal
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~ INSTALLED A Back to top

Blender Development

Jacques Lucke

C/C++

£ Microsoft

GitHub Copilot

£ GitHub

GitHub Copilot Chat
2G TH.J‘[V

GitHub Pull Requests
‘ar:..m.m |

GitHub Repositories

n @ 0 6@

alﬁ tHub

Pylance

Python

br"“"fi soft
Python Debugger
e

Remote Repositories

S UL U

£ Microsoft

8. Fork IfcOpenShell project from GitHub: For this step you will need an account on GitHub.
Once you have a registered account you can find it under https://github.com/
YOURGITHUBUSERID In the example for falken10Ovdl the link is https://github.com/
falken10vdl

= O falken10vdl Q Type (/] to search

[ overview [J Repositories 1 [ Projects @ Packages Yr Stars 1
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Popular repositories

Spoon-Knife Public
Forked from octocat/Spoc /I\ BaCk to top

This repo is for demonstration purposes only

@ HTML

falken10vdl 25 contributions in the last year

Contribution settings

Go to the IfcOpenShell GitHub page. And click on the Fork button. Please make sure that
you are logged with your GitHub account as shown in the top right corner of the page.

O B https://github.com/IfcOpenShell/IfcOpenShel 0O O v ® =

= O IfcOpenShell IfcOpenShell Q v + ~ OB YRIR=! .
=

<> Code (©) Issues 959 {1 Pullrequests 32 ) Discussions (® Actions f Projects 2 J wiki © Security |~ Insights

'3 IchpenShe" ) Sponsor 52 EditPins v ®Watch 91 ~ %9 Fork 766 @ vy Star 2k

Existing forks X

You don't have any forks of this repository.

ary and geometry

17,500 Commits engine

o
sts
aws/lambda
choco/bonsai
cmake
conda
docs
nix
Releases 1,877

pyodide bonsai-0.8.2-alpha2503201130 ...

Once the fork is generated you will be redirected to your own fork of the IfcOpenShell
project.

€ 2> C O & https://github.com/falken10vdl/IfcOpenshel

Olfalkenwvdl lchpenSheIIl Q Type

<> Code {1 Pullrequests () Actions [ Projects [0 Wiki @ Security [~ Insights i Settings

@ Ifcopenshell > Pin  ©Watch 0 ~

forked from

¥ v0.8.0 ~ Pk h © 0Tag ) Got ¥ <> Code ~ About

Open source IFC library and geometry

) ) ) o . ‘ - ) . - . ~
This branch is up to date with 1 I v E 11 Contribute & Sync fork engine

0 aothms Apply skew in infra lof 4c2844 O 17,500 Commits
B github
I aws/lambda

B choco/bonsai

Now we will clone the forked repository to our local machine.

9. Clone bonsai to our development environment: Launch VSCode Select the Source

1 Yl r ~can ”
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@ Clone from GitHub

A Back to top

Visual Studio Code
Editing evolved

Start Walkthroughs

-2 Get Star

S

® Gittiub Copilot e Welcome to Copilot

8 Browse & Edit Rem

Recent @ Get Started with Python
You have no recent folders,

@ Get Started with C++ Development (W

A series of steps will be required to authenticate with GitHub. You will need to provide
your GitHub credentials. Once VSCode has authenticated yourself in GitHub, you will be

able to select the repository you want to clone. In this case we will clone the IfcOpenShell
repository.

ame (
) Welcome X

Open Folder
Clone Repository

it and source controlin VS Code read ou

Visual Studio Code
Editing evolved

VSCode will ask you to select a folder where the repository will be cloned. and it will start
the cloning process.

Once finished, you will see the repository in the Explorer tool.

Visual Studio Code
Editing evolved

Start Walkthroughs
P Get Started with VS Code

Recent

10. Link the Bonsai addon to the local cloned repository: We will now edit the following
script that establishes links from the unstable-installation to the cloned repository so we

can easilv see the chanaes done in the cloned renositorv taken effect when we load
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blender locally.
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http://localhost:8000/quickstart/ide/windows_ide.html
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Edit the file to match the paths in your system. In our case we will edit the following lines:

o SET REPO_PATH=%HOMEDRIVE%\Users\%USERNAME%
\Documents\bonsaiDevel\lfcOpenShell

o SET BLENDER_PATH=%HOMEDRIVE%\Users\% USERNAME%
\AppData\Roaming\Blender Foundation\Blender\4.2

o SET PACKAGE_PATH=%BLENDER_PATH%\extensions\.local\lib\python3.11\site-
packages

o SET BONSAI_PATH=%BLENDER_PATH%

\extensions\raw_githubusercontent_com\bonsai

You need to run it as an administrator. We execute the script in the terminal. Confirm the

data and the script will create the necessary links.

.\dev_environment.bat

[&%] Administrator: Command Prompt

C: \Users\falke\Documents\bonsaiDevel>. \dev_environment . bat

LIVE DEVELOPMENT ENVIRONMENT
Update REPO_PATH, BLENDER_PATH, PACKAGE_PATH, BONSAI_PATH in the s
This script needs to be run as administrator (to create symbolic link:
Make sure you have followed these steps before proceeding :)

currently set paths:

Please review if the following is right:
PWD: C:\User: alke\Documents\bonsaiDevel

.\IfcOpenshell): C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell
[BLENDER PATH: C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2
[PACKAGE PATH (
[BONSAI PATH (..

Press any key to continue .
i directory. ..
ists in .gitignore
copy over compiled IfcOpenshell files.

1ib\python3.11\site-packages): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\
\extensions\raw_githubusercontent_com\bonsai): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\d.2\extensions\raw_githubusercontent_com\bonsai

te-packages

C: \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell\ifcopenshell_wrapper.py

C: \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions
2 file(s) copied.

C: \Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\ifcopenshell

symbolic link created for
sai\_init__.py

symbolic link created for
i

Cannot create a file when that file already exists.

symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.
ccsv.py

symbolic link created for
ifcdiff.py

symbolic link created for

rs\falke\AppData\Roaming\Blender Foundation\Blender\4. ensions\.

rs\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.

C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.

ymbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4 ensions\.
ymbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.
json\ifccityjson
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.
fcclash
symbolic link created for C
fcpatch
symbolic link created for C:
\ifctester
symbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.
Manually downloading some third party dependencies
% Total % Received % Xferd Average Speed
Dload Upload
100 228k 188 228k e © 2646k ] == LI H s L H
% Total Received % Xferd Average Speed i Time Time
Dload Upload Spent Left
100 18913 e e 524k e H e H
% Received % Xferd Average Speed i Time Time Current
Dload Upload Spent Left Speed
e e e e e e e
Warning: Failed to open the file C:\Us
@ 1726k e e e ] ]
curl: (23) client returned ERROR on write of 4134 bytes
Press any key to continue .

\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.

ers\falke\AppData\Roaming\Blender Foundation\Blender\4 ensions\.

Current

100 18913
% Total

]
\falke\AppD:
e

C: \Users\falke\Documents\bonsaiDevel>

Warning

If you receive errors like this:

C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\ran_githubusercontent_com\bonsai\_

local\lib\python3

local\lib\python3.
local\lib\python3.
local\Lib\python3.
local\Lib\python3.
local\lib\python3.
local\lib\python3.
.local\lib\python3. 1:
local\lib\python3.
local\Lib\python3.

local\Lib\python3.1

local\lib\python3.

local\Lib\python3.11\site-packages\ifcopenshell\_ifcopenshell_wrapper.cp311-win_amdé4.pyd

fcopenshell_wrapper.cp311-win_amd64.pyd - Access is denied.
t_.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bonsai\bon

.11\site-packages\bonsai < C:\Users\falke\Documents\bonsaiDevel\IfcOpensShell\src\bonsai\bonsa

11\site-packages\ifcesv.py << Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccsv\if

11\site-packages\ifcdiff.py << C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcdiff\

11\site-packages\bsdd.py <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\bsdd\bsdd.p
11\site-packages\bcf <
11\site-packages\ifcad <
11\site-packages\ifcsd <
1\site-packages\ifccityjson

C:\Users\falke\Documents\bonsaiDevel\IfcOpensShell\src\bcf\bcf

>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcad\ifcad
sers\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifc5d\ifc5d
> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifccity

11\site-packages\ifcclash < > C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcclash\i

11\site-packages\ifcpatch <<===>> C:\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcpatch\i
1\site-packages\ifctester << :\Users\falke\Documents\bonsaiDevel\IfcOpenshell\src\ifctester

11\site-packages\ifcfm sers\falke\Documents\bonsaiDevel\IfcOpenShell\src\ifcfm\ifcfm

Foundation\Blender\4.2\extensions\.local\lib\python3.11\site-packages\bonsai\bim\schema\Brick.ttl: No such file or directory
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The system cannot find the path specified.

It means that you have not installed the Bonsai Blender extension. Please refer to tha last part of point 2.

above and follow the Unstable installation. 4 Back to top

11. Adjust the VSCode Blender extension: We will now make some adjustments to the
VSCode Blender extension to ease the reload of the addon. Select the Extensions tool.

Then [Blender Development] and then select .

® = Settings X = a8 -

BO0DEm0 - o X

\f

blender-development 13 Settings Found ==

Backup and Sync Settings

Blender: Additi

GitHub Copilot

) i ¢
& GitHub
r>Addon: Build Task Name

GitHub Copilot Chat X
t > ats

& GitHub

GitHub Pull Requests

& GitHub ‘

GitHub Repositories

& GitHub

Pylance

mant, f
& Microsoft

Click twice in “Add Item” within the Blender: Additonal Arguments section and add the
following two items (adapt Testing.ifc to the name of the IFC file you want to test during
Bonsai development):

o —python-expr

o import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\
\bonsaiDevel\\Testing.ifc”, should_start_fresh_session=True, use_detailed_tooltip=True)

< Settings X

@extJacquesLucke.blender-development 13 Settings Found = W

User Workspace Folder v Backup and Sync Settings

v Extensions (13)
&

Blender: Additional Arguments
Blender (13) - i X
Additional arguments used for Blender start-up. List of strings.

--python-expr
import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\\bonsaiDevel\\Testing.ifc", should_start_fresh_session=True, use,detaﬂed,tooltip:Trusf X

Add Item

Warning

Note the double backslash in the path for correct interpretation by VSCode

Make sure that Blender > Addon: Just My code is not selected (This allows to set the
breakpoints anywhere in the source code).

U WEID - O X

v

@ext:JacquesLucke.blende " 13 Settings Found =
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Backup and Sync Settings
Blender Development

Tools to simplify Blender development
Jacques Lucke %% e Blender > Addon: Just My Code

j only the code
C/C++

GitHub Copilot

& Microsoft N Back to top
- Blender > Addon: Load Directory

& GitHub

Warning

This way to use the VSCode Blender extension is not the standard one. Refer to the VSCode Blender
extension documentation for the standard way to use it. The reasond behind is that this allows us to start
VSCode in the top of the cloned repository so all the Git related funtionality in VSCode works properly and

we have a complete view from VSCode tool of the whole repository.

Bonsai is a big project with a lot of dependencies so reloading it it is not an easy task (see discussion in
https://community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1). We have
taken the pragmatic approach to start blender with a specific file (7esting.ifc) and then we can reload the
addon from the Blender Ul which also upload automatically the changes in the addon and the testing file To
summarize:

o We need Blender > Addon: Just My code to get the breakpoint functionality even if the addon is not
“registered/loaded” to the extension (due to the root folder we use)

o We need Blender: Additonal Arguments to automatically load the Testing.ifc file when we start Blender
from VSCode (We do not use Blender:Reload Addons since it does not work in our case)

Instead of restarting Blender from VSCode, we use the Blender Ul that, as explainedin the next step, it
provides a simple way to get the addon and the Testing file reloaded.

12. Launch blender from VSCode: We are now ready to launch Blender from VSCode. Open
VSCode. Open the cloned repository if not already open. Press CTRL-SHIFT-P and type
“Blender: Start”.

DB O0 - o X

Walkthroughs

Recent

Blender will start loading the Testing.ifc file. You can now start exploring the code and
make changes to the addon!
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In order to be able to restart blender (and reload the addons + reload teh Testing file) we

need to enable “Developer Extras” and also a good practice is to enable “Python Tooltips”

in |Edit » Preferences > Interface|.

Interface
Viewport
Lights
Editing

Animation
Get Extensions

Add-ons

Themes

Input
Navigation

Keymap

System
Save & Load
File Paths

Experimental

Blender Preferences

v Display

Resolution Scale
Line Width

1.00
Default
+ Splash Screen

« Developer Extras

Tooltips

Search

v Editors

Color Picker Type
Header Position

Factor Display Type

> Temporary Editors
> Status Bar

v Language

Language

+ User Tooltips
+ Python Tooltips

+ Sort by Most Recent

+ Region Overlap

« Navigation Controls
Circle (HSV)
Keep Existing

Factor

English (English)

Once these are enabled, you can press F3 and write restart to restart Blender.

D File
=y @ O

e Collection

Edit Render Window Help

VRl o}

Vv E 2
(] Ja )3

(Unsaved) - Blender 4.2.8 LTS

W) ObjectMode v View Select Add Object 13 Global v (Pv § Mix v (s

BIM &5~ Scene fin] M
(v @ 0 ©O@OO « & 17C Object Mode v
Options v

SoCcaxtUD

ViewLayer [

45 Scene
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13. Add a break-point: Let's add a break-point in the code to see how it works. Press
CTRL_SHIFT_P and type “Blender: Start”. Blender will start. Open the cloned folder and

go to src > bonsai > bonsai > bim > module > ligth > prop.py and go to line 75. Add a line
for a print statemente and click on the left side of the line number to add a break-point.

74  def update_shadow_mode(self,
75 print("Shadow mode", self
76 if self "SHADING":

Set a break-point in line 75.

*(Unsaved) - Blender 4.27 LTS

biect T clobat v v [ wx + (8
copensHELL 0
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In Blender. Go To SOLAR ANALYSIS Tool in Bonsai and Click in “No Shadow”, “Shaded” or

“Rendered”
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/I\ Back to top tool.Blender.ge
hading. type !

.shadow_mode == "RENDERING":
context.scene.sun_pos_properties.sun object :
light add(t ="SUN", radius=1, alig

WATCH

Set units

11 0.00
1t 0.00

Create project ::

CALL STACK

MainT

run
run

server_thread_function

Place obje
Setup arra

BREAKPOINTS

11 0.00

11 0.00

11 0.00

11 0.02

Setting default conte
Import finished in 0.6¢
Warning: File written by wer Blender binary (403.34), expect loss of data!

From here you can watch the local variables, global variables, add watches, check the

stack, etc. Resume execution or move step by step to see how the code is executed.

CONGRATULATIONS! You have now a development environment ready to explore the

Bonsai code and contribute to the project.

14. Make changes and do a Pull Request to the project: In the previous steps we got a

complete IDE to explore and make changes to the Bonsai sourcecode. In this step we will

provide a simple workflow of using Git commands within VSCode to make changes and

do a Pull Request to the project. Bonsai changes very fast so our cloned repository will be

outdated very soon. We propose to do the following:

a. Check in our GitHub page if our project fork (https://github.com/falken10vdl/
IfcOpenShell) is outdated compared to the [fcOpenShell main branch (https://

github.com/IfcOpenShell/IfcOpenShell).

b. Sync our fork with the upstream branch (if needed).

c. Pull the changes in our porject fork to our local repository (/home/falken10vdl/

bonsaiDevel).

o

. Make changes in the code.

. Commit the changes.

> Q - O

. Push the changes to our project fork.

. Create a new branch in our local repository (example: DOC_QS_IDE)
. Publish the branch to our project fork in GitHub.

i Cranta A~ Dl Daniiact +A +thAa tinctrananm mmain hvanch Af +HhA IFANAAWRChALL AvrATlAA+

21 de 27

2025-03-28, 11:37


http://localhost:8000/_images/break-point-stop.png
http://localhost:8000/_images/break-point-stop.png
https://github.com/falken10vdl/IfcOpenShell
https://github.com/falken10vdl/IfcOpenShell
https://github.com/falken10vdl/IfcOpenShell
https://github.com/falken10vdl/IfcOpenShell
https://github.com/IfcOpenShell/IfcOpenShell
https://github.com/IfcOpenShell/IfcOpenShell
https://github.com/IfcOpenShell/IfcOpenShell
https://github.com/IfcOpenShell/IfcOpenShell
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#

Windows - Bonsai 0.8.2 documentation http://localhost:8000/quickstart/ide/windows_ide.html

. “ITAlT a I Ull NTYUTOL WU LUIT upsu calli iriaii viaticil vl Ui 1ivupyciiolicue prujcod.

Letis see below the steps with an example of changing the documentation of the

Quickstart guide for the IDE in Linux.
A Back to top

a. Check in our GitHub page if our project tork I1s outdated. Click Update branch
€ > C C & httpsi/igithub.com/falkentOvdl/ifcOpenshell

— O falken10vdl IfcOpenShell

> Code I Pull requests ») Actions [ Projects [0 Wiki @ Security ~ Insights & Settings

@ I1fcopenshell P @Wach 0 -

forked from
¥ v0.8.0 ~ F1

This branch is

@ aothms

m .github

<> Code ~ About

Open source IFC library and geometry

{1 Contribute ~ engine

o>

& Syncfork ~

to This branch is out-of-date

BB aws/lambda

choco/bonsai

Compare
cmake i
Releases

docs

nix ) t Packages

|
|
B conda ) Update branch
|
]
|

pyodide

b. After clicking Update branch our fork is up to date with the upstream main branch.

S = (6 O 8 https://github.com/f

O falken10vd| IfcOpenShell

> Code )} Pull requests ») Actions [ Projects ) Security Insights 3 Settings

@ I1fcopenshell £ Pin | ®Wtch 0 ~

forked from

<> Code ~ About

) ) ) ‘ = Open source IFC library and geometry
This branch is up to date with {1 Contribute ~ G Syncfork - engine

) File Edit Selection View Go Run Terminal Help IfcOpenShell

o X
SOURCE CONTROL prop.py M = Settings X D B8

> CHANGES

eI D ifcopenshell 3 Auto © @ext:JacquesLucke.blender-development
Apply skew in infra lofts #6386
User Workspace
ISSUE #6328 fix in dispatch_token to avoid missing

Retrieve length unit info from underlying mapping in iterator

13Settings Found =%

Backup and Sync Settings

ifcsverchok - ifc.write_file_panel to filter .ifc files Blender: Additional Arguments

node.sv_ifc_create_file_refresh - fix LB Out bL_label A Additional arguments used for Blender start-up. List of strings

ifcsverchok - remove debug print Andr python-expr

node.sv_ifc_tooltip - hide title . .
import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vd|/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool

typing

Read settings from argparser Add Item

d. Create a new branch in our local repository by clicking in the current branch name in the
bottom left corner of the VSCode window. Give a name to the branch and press Enter.

) File Edit Selection View Go Run Terminal Help

SOURCE CONTROL
> CHANGES
) ™ GRAPH £ IfcOpenshell §° Auto sS4k AL D)
Fix Blender 4.4 errors starting some operators...(NOED &
Z}, The experimental cutting tool now supports a bisect mode fo
2 Minor fix to clipping planes if there is no camera D
See #6404. See #1227. Create axis context if it does not exist ..
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall

DOC_QsS_IDE

+ Create new branch...

=+ Create new branch from...
& Checkout detached

User Workspace

v Extensions (13)
Blender: Additional Arguments
Blender (13

Additional arguments used for Blender start-up. List of strings.

DO - o x
=
13 Settings Found =

Backup and Sync Settings
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Some form of circle handling in loop_to_function_item_upgr..
Apply skew in infra lofts #6386 Thor i

ISSUE #6328 fix in dispatch_token to avoid missing unknown ..
Retrieve length unit info from underlying mapping in iterator
ifcsverchok - ifc.write_file_panel to filter_ifc files Andrej
node.sv_ifc_create_file_refresh - fix LB Out bl_label
ifcsverchok - remove debug print

node.sv_ifc_tooltip - hide title And

http://localhost:8000/quickstart/ide/windows_ide.html

--python-expr

import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool]

Add Item

Blender > Addon: Build Task Name

ed before the addon can be loaded into Blender

- ! A Back to top

Read settings from argparser

pyodide demo: install shapely

Update publish-pyodide-demo-app.yml

Update wheels #6402

Blender 4.4 - fix broken Ul lists #6396.

Implement readable setting type retrieval 25 Krijn
Reinstate old bespoke model-offset/rotation parsing in IfcCo...
Normalize model-rotation quaternion The j

Bonsai makefile - fill last_commit_date

Fix missing default value for *last_commit_date" (37ec2bf) #...
Use explicit *bl_ui_utils.layout" import to fix #6389

debugging docs - add section about debugging addon A

get distance along alignment from station... Richard Br

See #1227. Fix bug where unjoin walls didn't recheck the posi.
Fix #6318. Fix warnings when decorator cannot convert 3D to..
Quantification to consider Pset_ProfileMechanical.MassPerLe.
quantification fallback - small clarification

typing

black ouTPUT
Issue #5130 fix + sheet all expand and contract (#6379)

Fix #6372. See #1227. More reliable layer slicing. Always slice
See #1227. Clear cache when activating drawings. n t
get_shape_aspects to consider element's type #6374... And

Fix Ul errors i case of uppercase unit names (7af6727).

®0A0

Blender > Addon: Extensions Repository

Blender extensions only: repository to use when developing addon
Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)

vscode_development

Blender > Addon: Just My Code

f true, debug only the code in this addon. Otherwise, allow stepping into external python library code

Blender > Addon: Load Directory

Directory that contains the addon that should be loaded into Blende

auto

Blender > Addon: Module Name

Name or the symlink that is created in Blenders addon folder

The new branch is created and we can see it in the bottom left corner of the VSCode

window.

expan

Fix #6372. See #1227. More reliable layer slicing. Always slice ...

See #1227. Clear cache when activating drawings. [

get_shape_aspects to consider element's type #6374...

IfcOpenShell (G

¥ DOC_QS_IDE* &

[

t) - Publish Branch

® 0

1se unit names (7af6727)...

R FiYsiaTlala)!

e. Publish the branch to our project fork in GitHub by clicking in the publish button (little
cloud with up arrow) in the bottom left corner of the VSCode window. Select as origin

the project fork.

) File Edit Selection View Go Run Terminal Help

SOURCE CONTROL origin https://

0O - o x
D B8

> CHANGES upstream http hub.com/If

~ GRAPH E] ifcOpenshell §° Auto * @ 0 =+ Add a new remote.

Fix Blender 4.4 errors starting some op... (©FOCIGSHED &
User Workspace
The experimental cutting tool now supports a bisect mode fo.
Minor fix to clipping planes if there is no camera e a——
See #6404, See #1227. Create axis context if it does not exist i
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall .
Some form of circle handling in loop_to_function_item_upgr
Apply skew in infra lofts #6386 Thomas Kri
ISSUE #6328 fix in dispatch_token to avoid missing unknown
Retrieve length unit info from underlying mapping in iterator
ifcsverchok - ifc.write_file_panel to filter .ifc files Andrej73
node.sv_ifc_create_file_refresh - fix LB Out bl_label
ifcsverchok - remove debug print An
node.sv_ifc_tooltip - hide title A
typing
Read settings from argparser
pyodide demos install shapely
Update publish-pyodide-demo-app.yml
Update wheels #6402
Blender 4.4 - fix broken Ul lists #6396,
Implement readable setting type retrieval Thomas Krijn
Reinstate old bespoke model-offset/rotation parsing in IfcCo
Normalize model-rotation quaternion j
Bonsai makefile - fill last_commit_date... A 3
Fix missing default value for *last_commit_date" (37ec2bf) #...
Use explicit *bl_ui_utils.layout" import to fix #6389
debugging docs - add section about debugging addon A
get distance along alignment from station hard Br
See #1227. Fix bug where unjoin walls didn't recheck the posi
Fix #6318. Fix warnings when decorator cannot convert 3D to...
Quantification to consider Pset_ProfileMechanical.MassPerLe.
quantification fallback - small clarification A
typing
black 1S oUTPUT
Issue #5130 fix + sheet all expand and contract (#6379)...
Fix #6372. See #1227. More reliable layer slicing. Always slice

See #1227. Clear cache when activating drawings.

13 Settings Found =%

Backup and Sync Settings

Blender: Additional Arguments

Additional arguments used for Blender start-up. List of strings.

~-python-expr

import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool]

Add Item

Blender > Addon: Build Task Name

Task that should be executed before the addon can be loaded into Blender

Blender > Addon: Extensions Repository

Blender extensions only: repository to use when developing addon.
Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)

vscode_development

Blender > Addon: Just My Code

f true, debug only the code in this addon. Otherwise, allow stepping into external python library code

Blender > Addon: Load Directory

Directory that contains the addon that should be loaded into Blende

auto

Blender > Addon: Module Name

Name or the symlink that is created in Blenders addon f

ter Tasks
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get_shape_aspects to consider element's type #6374

Fix Ul errors in case of uppercase unit names (7af6727)... And.

§° DOC_Gs _| A

Check that the branch is now in our nroiect fark in GitHub.
A Back to top

B O falken10vdl/IfcOpenShell X +
« > C O B https://github.com/falken10vd|/IfcOpenShell
5 AlmaLinux % Documentation f*Blog f* Bug tracker % GitHub organization

= O falken10vdl / IfcOpenShell Q Type (/] to search

<> Code 71 Pullrequests ( Actions [ Projects [0 Wiki @ Security |~ Insights 83 Settings

@ Ifcopenshell ru 2 Pn | @ wateh

forked from

¥ v0.8.0 ~ ¥ 2 Brar Add file ~ <> Code ~ About

Switch branches/tags Open source IFC library and geometry
5 19 Contribute ~ O Syncfork ~ engine

Q_ Find or create a branc
Readme

{ 17,506 Commits

Branches = Tags GPL-3.0 license

v v0.8.0 default Update publish-pyodide-demo-app.yn

BOCQSIDE migrate docs urls

View all branches bonsaibim u

0 stars
0 watching

m
i
A~ Activity
w
(O]
% 0 forks

cmake Don't allow emp 1a for add_commit_sha
Releases

conda bonsaibim urls .
s published
docs docs: include doxyge submodule

nix Update build-all.py; -- when fetch tags Packages

pyodide wasm wheel fixes 2 months ago No p:

Languages

variant storage (

win Fetch boos github rele n build scripts 2 months agc C++76.2% Python 20.1%
C2.6% Gherkin 0.4%
.clang-format clang-format: remove duplicates from base style 2y ® javascript 0.2% @ SWIG 0.1%

® Other 0.4%

.
]
]
.
.
B src Fix Blender 4.4 errors starting some operators
.
.
b
b

.clang-tidy clang-tidy: add basic checks

f. Make changes in the code. In this case we will change documentation by adding a
Quickstart for the IDE in Windows. :)

XPLORER

* UNTITLED (WORKSPACE) e <> quickstart > ide > E wind
v lfcOpenshel ¢ s - In the previous steps we got a complete IDE to explore and make changes to the Bonsai sourcecode.
a new branch in our local repository by clicking in the current branch name in the bottom left corner of the VSCode window. Give a name to the branch and press Enter

ge:: images/new-branch-local.png
Adth: 1000 px

Publish the branch to our project fork in GitHub by clicking in the publish button (*Little cloud with up arrow?) in the bottom
left corner of the v win a the project fork.

h-publish- b.png.

Check that the branc project fork in GitHub.

age:: images/ne ate-github.png
idth: 1000 px

Make changes in the code. In this case we will change documentation by adding a Quickstart for the IDE in Windows.

inages/make-changes. png
1000 px

§. Commit the changes
First provide

images/git-user-email.png
dth: 1000 px

Then comit the changes by clicking in the check mark in the Source Control tool

images/commit-changes..png
th: 1090 o

g. Commit the changes.

First provide your user name and email to Git.

TERMINAL

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.email
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.name
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> ]
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Then commit the changes by clicking in the check mark in the Source Control tool.

| File Edit Selection View Go (MMEEEIQTRIe]Y]

SOURCE CONTROL

v CHANGES

Add quickstart for Windows ID

@ v/ Commit
v Changes

Accept the staging of the changes prior to commit.

Visual Studio Code

There are no staged changes to commit.

Would you like to stage all your changes and commit them directly?

Never Always Cancel Yes

h. Push the changes to our new branch in the github project fork.

e Edit View Go Run Terminal Hel IfcOpenShell
SOURCE CONTROL £ index.rst X

v CHANGES src > bonsa ocs > = index.rst
> IfcOpenShell ¢ ¥ poc. DE* v o y builder html and (not singlehtml)
N t T toc-cards
> input
global-index-toc
> mvd
> svfill
Sample-BIM-Files
Quickstart
2

quickstart/introduction to bim
cityjson 9488c8d O v I3 O - quickstart/installation
quickstart/explore model

Check that the changes are in the project fork in GitHub. You can see that the directory
ide has been added, for example.

= O falken10vdl / IfcOpenShell ‘ % + - lolnlla .

(> Code Il Pullrequests () Actions [ Projects [ wiki ) Security [~ Insights 83 Settings

[ Files J quickstart / (& Add file ~

7 DOCQS.... 2 [ & @ falkentovdl Add qu for Wind v D History

This branch is

Il Contribute ~ & Sync fork ~

Name

B ide

nix B images
pyodide _

[ create_model.rst
src
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> BB bcf 9 explore_model.rst

v [@ bonsai installation.rst

> [ bonsai - . .
introduction_tg
> I build A Back to top
9 next_steps.rst

i. Create a Pull Request to the upstream main branch of the IfcOpenShell project. Go to
your GitHub page and you will see that the new branch has 1 commit ahead of the
upstream main branch. Click in the Compare & pull request button.

« > C O @8 https:/github.com/falken10vdl/IfcOpenShelljtree/DOC
= () faleniowt / trcopenshel

<> code I Pullrequests (® Actions [ Projects [0 Wiki @ Security ~ Insights €3 Settings

@ Ifcopenshell £ P @Wach 0 ~

forked from

¥ DOC_QS_IDE had recent pushes 36 minutes ago Compare & pull request About

Open source IFC library and geometry

engine
¥ DOC_QS_IDE ~ 5 ©0Ta Q f t <> Code ~

This branch is I i ; 17 Contribute ~ O Syncfork ~

@ ralkentovdl ‘ fo E ) 17,507 Commits

Verify that the changes are correct, add a description
request button.

« > C O 8t ttps://github.com/IfcOpenShell/IfcOpenShell/compare/v0.8.0...falken10vdl:IfcOpenShe
= O IfcOpenShell IfcOpenShell

<> Code () Issues 962 {1 Pullrequests 32 ) Discussions ») Actions [ Projects 2 0 wiki © Security ~ Insights

Comparing changes

1 base repository: IfcOpenShell/IfcOpenShell ¥ € head repository: falken10vdl/IfcOpenShell ¥  compare: DOC_QS_IDE ¥

Able to merge. The

LULIER
Helpful resources

Add quickstart

Add a description

Write Previe k 4 > @ o ¢ @ [ « [

This is documentation with all the steps required to implement a simple yet powerful IDE workflow to work with Bonsai
Sourcecode

I Markdown is supported (A Paste, drop, or click to add files

¥ Allow edits by maintainers 2|/ Create pull request -

CONGRATULATIONS! You have now made a change in the Bonsai project and created a
Pull Request to the main branch of the project. Happy coding and documenting!

2025-03-28, 11:37


http://localhost:8000/_images/private-fork-new-branch-updated.png
http://localhost:8000/_images/private-fork-new-branch-updated.png
http://localhost:8000/_images/compare-and-pull-request.png
http://localhost:8000/_images/compare-and-pull-request.png
http://localhost:8000/_images/pull-request.png
http://localhost:8000/_images/pull-request.png
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#

Windows - Bonsai 0.8.2 documentation http://localhost:8000/quickstart/ide/windows_ide.html

A Back to top

iy
L

Copyright © 2020-2024 IfcOpenShell Contributors
Made with Sphinx and @pradyunsg's Furo

27 de 27 2025-03-28, 11:37


https://www.sphinx-doc.org/
https://www.sphinx-doc.org/
https://pradyunsg.me/
https://pradyunsg.me/
https://github.com/pradyunsg/furo
https://github.com/pradyunsg/furo
https://ifcopenshell.org/
https://ifcopenshell.org/
https://github.com/IfcOpenShell/IfcOpenShell/tree/v0.8.0/src/bonsai/docs
https://github.com/IfcOpenShell/IfcOpenShell/tree/v0.8.0/src/bonsai/docs
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#
http://localhost:8000/quickstart/ide/windows_ide.html#

